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The ArchiCAD 19 Package
ArchiCAD 19
ArchiCAD is a powerful modeling application which enables 
architects to design buildings more productively, based on the 
Virtual Building™ approach. ArchiCAD allows architects to focus 
on design, either alone or in Teamwork, while also exchanging 
data smoothly with consultants and professionals in other fields.
Install ArchiCAD 19 if you need to work in ArchiCAD, either in solo 
mode or as a member of a Teamwork project.

GRAPHISOFT BIM Server for ArchiCAD 19
The GRAPHISOFT BIM Server is a server application necessary to 
support Teamwork, a client-server technology that enables fast, 
simultaneous access to projects for multiple clients. The 
GRAPHISOFT BIM Server is connected through the network to 
several ArchiCADs, which are the clients in this system.
Each installation process is described in detail in this booklet.
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ArchiCAD 19
Hardware/Software Requirements
Internet
Fast Internet access is needed for connecting to BIM Server in a 
remote location and to download updates for ArchiCAD 19.
Protection Key
You will need an ArchiCAD 19 CodeMeter hardware key or 
CodeMeter Act software protection key to use the full 
commercial version of ArchiCAD 19.
See also “ArchiCAD License Protection Key” on page 13.

Recommended Operating Systems for ArchiCAD 19
• Windows 8.1 (64-bit version)
• Windows 8 (64-bit version)
• Windows 7 (64-bit version)
• Mac OS X 10.10 Yosemite
• Mac OS X 10.9 Mavericks

Notes on older systems
• Mac OS X 10.8 Mountain Lion is compatible but not tested by 

GRAPHISOFT.
• Mac OS X 10.6 Snow Leopard and Mac OS X 10.7 Lion are not 

compatible (ArchiCAD cannot be installed).
• Windows Vista is not compatible (ArchiCAD cannot be installed).
• Windows XP is not compatible (ArchiCAD cannot be installed).
6 Getting Started with ArchiCAD 19
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Recommended Hardware
• Processor: 64-bit processor with four or more cores.
• RAM: For complex, detailed models 16 GB or more may be 

required.
• Hard disk space: Installing ArchiCAD on an SSD (or Fusion) 

drive is recommended; 5 GB free disk space is required for 
the installation, 10 GB or more is required per active project.

• Graphics card: Dedicated Open GL 2.0 compatible graphics card 
with on board memory of 1024 MB or more is recommended 
to fully exploit hardware acceleration capabilities.

You can find a list of recommended video cards at:
http://helpcenter.graphisoft.com/technotes/video-cards.
• Display: A resolution of 1440 x 900 or higher is recommended.

Minimum Hardware
• Processor: 64-bit processor with two cores.
• RAM: 4 GB.
• Hard disk space: 5 GB or more is required for the installation.
• Graphics card: Open GL 2.0 compatible graphics card.
• Display: A resolution of 1366 x 768 or higher is required.

Other Software
Java 8 or later is required.
For details, see http://www.graphisoft.com/Java.

Note: ArchiCAD installer will automatically install Java 8, if it is 
are not already present on your computer.

Optional Hardware Peripherals
All major plotter, printers and digitizers can be used with ArchiCAD.
Getting Started with ArchiCAD 19 7
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Install ArchiCAD 19
Insert the ArchiCAD DVD into your computer’s DVD-ROM drive.

Start-up Presentation
A start-up presentation will be launched, giving you a short visual 
introduction to the capabilities of ArchiCAD.
If the start-up presentation is not launched automatically on 
Windows, double-click on the “Setup” application in the DVD root 
directory.

Start Installation Wizard
• On Windows: Click on Install GRAPHISOFT ArchiCAD 19 in 

the menu to start the ArchiCAD Installation Wizard.
- The installer will first check your Java environment. 

ArchiCAD installer will automatically install Java 8 if it is 
not present on your computer.
8 Getting Started with ArchiCAD 19
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• On Mac: The ArchiCAD volume will be mounted on your 
desktop. Open this volume and click the “ArchiCAD 19 Installer” 
icon to begin the start-up presentation.
Click on Install GRAPHISOFT ArchiCAD 19 in the menu to start 
the Installation Wizard.

There are two ways to proceed in the ArchiCAD 19 Installation 
Wizard:
• Install as a regular user, using the default, basic installation 

process.
• Install as BIM Manager, using additional configuration options.
Both processes are described below.

Install ArchiCAD Using Basic Configuration 
(Default)
On the Welcome screen of the Installation Wizard:
1) Click Next to enter the basic Installation Wizard.
Getting Started with ArchiCAD 19 9
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2) On the following screen, accept the license agreement.
3) Click Next again to skip to your next step, which is Program 

Folder Selection.
See “Program Folder Selection” on page 11.

Install ArchiCAD as BIM Manager
On the Welcome screen of the Installation Wizard:
1) Check the Install as BIM Manager checkbox at the bottom 

left of the Welcome screen. If you check this box, the screens 
of the Installation Wizard will include the following additional 
options: 
- Registration with a serial number for EDU or Trial versions, 

as well as regular protection key;
- Installation package creation.
10 Getting Started with ArchiCAD 19
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2) Click Next.
3) On the next screen (available for BIM Managers only), enter 

the type of your protection key, or your serial number. 
For details, see “Choose and Configure License Type” on page 15.
4) Click Next to proceed to Program Folder Selection.

Program Folder Selection
After accepting the license agreement, define a location on your 
computer’s hard drive for installing ArchiCAD 19.

Choose Setup Type
Choose one of the following:
• The Typical option installs all components of ArchiCAD 19. It 

is recommended to use this option when first installing 
ArchiCAD.

• The Custom option installs only the selected parts of the full 
ArchiCAD package. Choose Custom only if you are 
experienced in installing and using ArchiCAD.

If you are a BIM Manager:
• A third option, Installation Package Creation is also available. 

Choose this only if you have already configured and saved 
ArchiCAD defaults in a separate folder.

See details at “Create Installation Package for Predefined 
Company Standards” on page 16.

Start Menu Location (Windows 7 Only)
Define the Program Folder (default folder: GRAPHISOFT) in which 
to place the “ArchiCAD 19” menu.
Getting Started with ArchiCAD 19 11
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Installation Process
After viewing the summary of your installation choices, click 
Install to begin the installation process.

Shortcuts
As part of the installation process, you can create an 
“ArchiCAD 19” Desktop shortcut.
On Mac, you can also create a Dock icon.

Work Environment Profiles
As part of the installation process, if the installer detects an 
earlier version of ArchiCAD on your machine, you will have the 
option of importing any customized Work Environment Profiles 
from projects in versions ArchiCAD 9 through 18.
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Complete Installation
Click Finish to complete the installation process.
After installing ArchiCAD, restart your computer.

ArchiCAD License Protection Key
To use the commercial version of ArchiCAD, you must have either 
a Hardware or Software Key containing an ArchiCAD license.
• The Hardware Key is a physical CodeMeter keyplug.
• The Software Key is a software-based license key available to 

you online.

Start ArchiCAD
When you start ArchiCAD, the program automatically checks to 
see if you have a license available. If so, you are ready to work.
To update, download and otherwise manage your license keys, 
use the License Manager Tool, available at 
http://www.graphisoft.com/downloads/licensing/.
Getting Started with ArchiCAD 19 13
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If You Do Not Have A Protection Key
After installing ArchiCAD, start the program.
If the program finds that you do not have an available license, an 
appearing dialog box will help you with the next step.

• You can continue in Demo Mode.
• You can register for an Education or Trial license.
• If you have purchased a commercial license but it has not 

been activated or is unavailable, click Troubleshoot 
Commercial License to find out what to do.
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Choose and Configure License Type
This screen of the ArchiCAD 19 Installation Wizard is available 
only if you checked the Install as BIM Manager option on the 
Wizard’s welcome screen.
See “Install ArchiCAD as BIM Manager” on page 10.
Click the option that corresponds to your license type:

• Hardware or Software Key (for full commercial ArchiCAD 
license).

• Serial Number (for Education and Trial Licenses).
If you have an Education or Trial license, you will be asked to 
provide your user ID and serial number.

For information about License Types, see 
http://helpcenter.graphisoft.com/technotes/licensing/archicad-
license-types/.
See also “ArchiCAD License Protection Key” on page 13.
Getting Started with ArchiCAD 19 15
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Create Installation Package for 
Predefined Company Standards
This option of the ArchiCAD 19 Installation Wizard is available 
only if you checked the Install as BIM Manager option on the 
Wizard’s welcome screen.
See “Install ArchiCAD as BIM Manager” on page 10.

Introduction
With a Commercial and certain Education licenses, it is possible 
to create a custom installation package that contains all the 
company standard environment settings, such as:
• Work environment settings;
• DXF/DWG Translators or IFC Translators used by default;
• Project templates.
Distributing this installation package in the office makes it possible 
for all associates to have a copy of ArchiCAD customized according 
to the company standards determined by the BIM Manager.

Note for Educational Institutions: If your ArchiCAD license is 
registered to an educational institution, you can use the 
Installation Package Creation process to create a recorded 
installation and simplify the installation of multiple identical 
copies of the program - even if you wish to use factory 
defaults instead of custom-defined settings.

To do this, you (the BIM Manager) must first install ArchiCAD on your 
own computer, following the standard installation process, and 
configuring the program according to company standards, following 
the steps below. Then you will quit and re-install the program on a 
server (or different machine). This time, you will choose a special 
installation option which automatically records your installation 
process and creates an install package: a single executable 
application file to be launched on each end user’s machine.
16 Getting Started with ArchiCAD 19
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Custom Installation Package: Step by Step
To create a custom installation package, follow these steps:
1) Install ArchiCAD 19 onto your own computer following the steps 

under “Standard Installation”. Choose the “Typical” Setup.
2) After starting ArchiCAD, use Options > Work Environment 

dialog boxes to set up your company standard Work 
Environment settings. Most such options are found in three 
dialog boxes of Company Standard Schemes: Data Safety & 
Integrity; Network and Update; and Special Folders.
Once you have set these options, you can save these settings 
in schemes, then save the schemes in a company-default 
profile. To save a profile, go to Options > Work Environment 
> Work Environment Profiles.
Note: If you create new Work Environment schemes, and if 
you don’t want your Install Package to include the default 
ones created by the regular installation, then you should first 
copy the content of the Work Environment folder to the 
Defaults/ArchiCAD/WorkEnvironment folder. Then delete 
the unneeded schemes from this latter folder.

Location of Work Environment Folder
• Windows 7 or 8:

- Users\<Username>\AppData\Roaming\Graphisoft\ArchiCAD
-64 xx.0.0 yyy R1 

• Mac:
- ~/Library/Preferences/Graphisoft/AC-64 xx.0.0 yyy v1

where xx stands for the version number of ArchiCAD and yyy is 
the language version of ArchiCAD.
3) Create and save any number of template files. Template files 

include libraries loaded through Library Manager (e.g. “Office 
Standard Library”). Templates can also include Project 
Preferences (e.g. Working Units, Zone calculation 
preferences), and such items as Master Layouts, Project Info, 
placed elements (e.g. Elevation markers, entire buildings).
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4) Use the DXF-DWG Translation Setup dialog box (File > File 
Special > DXF-DWG Translation Setup, to set up DXF/DWG 
Translators and save them to a shared folder on a server that 
is accessible to all users. (In this case, a DXF-DWG 
TranslatorList.xml file is created, which is a list of references 
to these translators.) You can also create local translators that 
you want to install on the hard disk of each user.

5) Use the IFC Translation Setup dialog box (File > File Special > 
IFC2x3 > IFC Translation Setup) to set up IFC Translators and 
save them to a shared folder on a server that is accessible to 
all users. (In this case, a IFC TranslatorList.xml file is created, 
which is a list of references to these translators.) You can also 
create local translators that you want to install on the hard 
disk of each user.

6) Quit ArchiCAD.
7) Create a new folder entitled “Defaults”. Following the 

hierarchy below, copy the following files/folders into the 
“Defaults” folder:

Defaults
ArchiCAD (folder containing Work Environments and 
Templates)

WorkEnvironment (folder containing WorkEnvironment 
files)
Template file(s) (extension .tpl)

Dxf-Dwg Translator List.Xml
Dxf-Dwg Translators (folder containing Dxf-Dwg translators)
IFC Translator List.Xml
IFC Translators (folder containing IFC translators)

8) Uninstall ArchiCAD from your machine before running the 
Installer again. Alternatively, run ArchiCAD Installer on the 
server or on another machine.
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9) When you get to Choose Setup Type, choose the Installation 
Package Creation option. The screens of the Installation 
Wizard will now show the message “Recorded Installation.”

10) Proceed through the screens of the Installation Wizard and 
set options for the content of the recorded installation 
package.

Feature (Component) Selection
Choose the components you wish to install.

Company Standards Defaults
Use the controls of this screen if you wish to include company 
standard components as part of the install package.

Note for Educational Institutions: If you are using the 
Installation Package Creation process to create a recorded 
installation that does not include customized settings, do not 
check the box on this screen. Your recorded installation 
process will then skip to the end of the process.
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Check the Install company standard defaults box.
Use the directory dialog box to indicate the path of the Defaults 
folder on your system which contains previously defined 
company standard content. The folder and its contents should 
take the form defined in Step 7 above. The program will check to 
ensure that the Defaults folder indeed contains default content. 
(If it does not, you will see a warning notice.)

ArchiCAD Work Environment Selection
Use the pop-up menu to define which Work Environment profiles 
should be included in the install package:
• ArchiCAD Factory Default Profile Set; or
• Predefined Company Standard Profile Set.
The selected profiles (referred to in a single .xml file) will be 
copied to each end user’s machine.

Note: The Work Environment Selection screen will appear 
only if:
- the components to be installed include ArchiCAD; and
- you have activated the Install company standard defaults 

checkbox; and
- the defined Defaults folder includes a WorkEnvironment 

subfolder.

DXF-DWG Translator List
Use this screen to specify the path of the translator list you want 
to include as part of the install package.
If you have defined company standard translators and have 
placed the resulting DXF-DWG Translator List.xml in the defined 
Defaults folder, check Install Predefined List of Translators. The 
paths of the translator files are displayed on the screen.
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After the package is installed on the end users’ machines, the 
users will have access to read-only templates of these referred 
translators (which are located on a server). To edit them, the 
users should create editable copies by duplicating them in DXF-
DWG Translation Settings.
If you want to use ArchiCAD’s factory default translators, do not 
check the “Install company standard defaults” box.

Note: This screen will appear only if:
- the components to be installed include ArchiCAD; and
- you have activated the Install company standard defaults 

checkbox; and
- the defined Defaults folder includes a file called DXF-DWG 

TranslatorList.xml.

Local DXF-DWG Translators
If you have defined company standard DXF-DWG Translators 
which you want to install on each end user’s machine, check 
Install Company Standard Translator(s). The names of these 
translators are shown in the box below.
When the package is installed on the end users’ machines, and 
when the program is first started, these translators will be copied 
to each end user’s machine.

Note: This panel will appear only if:
- the components to be installed include ArchiCAD; and
- you have activated the Install company standard defaults 

checkbox; and
- the defined Defaults folder includes at least one file called 

DXF-DWG Translator.xml.
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IFC Translator List
Use this screen to specify the path of the IFC translator list you 
want to include as part of the install package.
If you have defined company standard translators and have 
placed the resulting Translator List.xml in the defined Defaults 
folder, check Install Predefined List of Translators. The paths of 
the translator files are displayed on the screen.
After the package is installed on the end users’ machines, the 
users will have access to read-only templates of these referred 
translators (which are located on a server). To edit them, the 
users should create editable copies by duplicating them in IFC 
Translation Settings.
If you want to use ArchiCAD’s factory default translators, do not 
check the “Install company standard defaults” box.

Note: This screen will appear only if:
- the components to be installed include ArchiCAD; and
- you have activated the Install company standard defaults 

checkbox; and
- the defined Defaults folder includes a file called IFC 

TranslatorList.xml.

Local IFC Translators
If you have defined company standard IFC Translators which you 
want to install on each end user’s machine, check Install 
Company Standard Translator(s). The names of these translators 
are listed.
When the package is installed on the end users’ machines, and 
when the program is first started, these translators will be copied 
to each end user’s machine.
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Note: This panel will appear only if:
- the components to be installed include ArchiCAD; and
- you have activated the Install company standard defaults 

checkbox; and
- the defined Defaults folder includes at least one file called 

IFC Translator.xml.

Template Projects
If you have defined company standard Templates which you want 
to install on each end user’s machine, check Install Company 
Standard Template(s). The template files that you have copied to 
the Defaults folder are listed.
Upon installation on the end users’ machines, and when the 
program is first started, these templates will be copied to each 
end user’s machine. When creating a new project in ArchiCAD 
with the “Use a Template” option, end users will find these 
company standard templates listed in the pop-up, together with 
other, recently used template files.

Note: This screen will appear only if:
- the components to be installed include ArchiCAD; and
- you have activated the Install company standard defaults 

checkbox; and
- the defined Defaults folder includes at least one Template 

file.

Complete Recorded Installation
After viewing a summary of your installation choices, click the 
Install button on the screen to initiate the recorded installation.
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On the next screens, three additional options will be added to the 
recorded installation, and will be carried out on each end user’s 
machine.
• if the installer detects customized Work Environment Profiles 

from earlier ArchiCAD versions (9 through 18) on the end 
user’s machine, decide whether these should be imported to 
ArchiCAD 19 or not;

• decide whether an “ArchiCAD 19” desktop shortcut should be 
created on the desktop;

• decide whether the end user’s system should reboot 
automatically following the installation.

Finally, define the path to which the recorded file - an executable 
application - should be saved.
You have now created an installation package. When users 
launch this .exe application on Windows, or “ArchiCAD Installer” 
on Mac, on the server, the usual queries posed by the Installation 
Wizard are skipped; the installation begins immediately. The 
installed copy of ArchiCAD will have the previously defined 
default settings.
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Using a CodeMeter Server
If you would like to use network licenses (e.g. instead of single 
licenses), you will need a CodeMeter hardware key or software 
key. Contact your local GRAPHISOFT partner to order one or to 
exchange your existing single key(s).

Single or Network Keys
A so-called single key can hold one license for each GRAPHISOFT 
product (ArchiCAD, MEP, EcoDesigner Star, BIMx) and can be 
used locally. You connect the hardware key to your computer’s 
USB port or download the software key with License Manager 
Tool (LMT); if you have the CodeMeter driver installed (it is 
installed with ArchiCAD), your GRAPHISOFT product will find a 
license and will run in commercial mode. Each workstation in an 
office needs to have an individual key.
A network key can hold multiple licenses related to each product 
(ArchiCAD, MEP, EcoDesigner Star, BIMx). To share them across 
multiple computers you need a CodeMeter server. This 
arrangement provides more flexibility than having individual 
keys, as the licenses are allocated only when they are being used 
on one of the clients.

System Requirements for a CodeMeter Server
The CodeMeter server is part of the CodeMeter driver, so you 
only need to select a computer on your network that will act as a 
CodeMeter server. To set up a CodeMeter server as a network 
license server, you will need the following:
• A computer with network connection (should be running 

during work hours).
• The computer must have at least one free USB port, for 

hardware key only.
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• CodeMeter driver must be installed. Click on Tools and 
Utilities from the start-up screen, or browse your DVD 
directory for the CODEMETER folder.
Note: There is no need for a server-level operating system for 
the CodeMeter server. You can use one of the workstations 
as a CodeMeter server, and you must keep it running during 
work hours. Any computer that has recent Windows or OS X 
versions can be used (Windows 7, Window 8, Windows 8.1, 
OS X 10.8, 10.9, 10.10).

Set Up the Server
After you have your server running and the CodeMeter driver is 
installed, start the server as described below. All CodeMeter 
settings can be managed in CodeMeter WebAdmin. To start it:
• Open CodeMeter Center (from Applications or using the Start 

menu) and click on WebAdmin;
• or simply open localhost:22350 on your browser.
To enable the CodeMeter server:
1) Go to Configuration/Server tab.
2) Check Run Network Server checkbox.
3) Do not forget to Apply the changes.
From that point, the server runs and shares licenses on the local 
network.
• Check Run CmWAN Server checkbox to use the computer in a 

wide area network (WAN) and allow license accesses.
• Do not forget to Apply the changes.
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Client Side Settings
All clients on the local network should find the server 
automatically. In case this does not work (e.g. your server is in a 
different subnet, or you are connecting remotely through the 
Internet), then you may need to specify the server’s hostname IP 
address. On the client:
1) Open WebAdmin.
2) Configuration/Network.
3) Add the server to the Server Search List.
This field can have multiple entries; the client searches for 
available licenses in the specified order and only on the specified 
servers. Only when the list is empty does the client search for 
other available servers.

Access Control
With the default settings, all computers on the same local 
network (same subnet) can use a license from the server.
To restrict access:
1) Open WebAdmin.
2) Go to Configuration/Access Control.
If the Clients’ list is empty, anyone on the local network can use a 
license. If at least one entry is listed here, only the listed entries 
can request a license.

Note: If the server is public on the Internet, or no one is 
allowed to use a license, make sure that this list is filled out 
correctly to avoid unwanted license usage.

You may want to check who is using a license:
1) Open WebAdmin on the server computer.
2) Go to Server/User tab.
Here you can see a list of active clients and clients who have 
borrowed licenses.
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Set Up License Borrowing
If your network key has a license borrowing product, the clients 
can borrow a license.
For more information on License Borrowing, see
http://helpcenter.graphisoft.com/?p=25723.

IMPORTANT NOTE: Make sure all licenses are returned/
expired before you do any of the following:
- Upgrade the licenses on upgrade site.
- Install a new main version of ArchiCAD.
- Unplug the server CodeMeter key from the computer or 

transfer it to a different one (even one with the same 
network specification).

- Uninstall or reinstall the CodeMeter driver (updating it is 
fine).

- Re-install the Operating system.
- Change the IP address of the server computer.

There is no additional setting needed to enable license borrowing 
but you may customize the following settings.

Borrow Duration
By default the borrowed licenses are valid for 30 days. If the 
license is not returned within this period, the license will expire 
and will be automatically returned to the server. To customize 
this maximum time (up to 30 days):
1) Open WebAdmin.
2) Go to Configuration/Borrowing.
3) Set the preferred Maximum Borrow Duration, in minutes.
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Maximum Number of Borrowable Licenses
You can also maximize the number of licenses available for 
borrowing. Enter the preferred number in the ‘Maximum Borrow 
Quantity’ field. This value cannot exceed the available license 
quantity of the borrowing product. Visit 
http://www.graphisoft.com/downloads/licensing/ 
to list the number of licenses you have and check the quantity of 
the LBRK (for keyplug based borrowing) or LBRA (for file based 
license borrowing) products.

Server Identification
Each client identifies the server by either host name or IP 
address. This can be customized on the server level, so when the 
server issues the license, the client gets the chosen address and 
will try to return the license to the given address. On networks 
with reliable DNS settings, Server name identification is the best 
choice, but on networks without it, or in mixed platform 
environment (Mac & Windows), choose identification based on IP 
addresses. In that case it is important to use static IP address for 
the Server.

Note: To customize all of these settings (Borrowing settings 
and Server Identification), check the Overwrite Entry Settings 
box in the License Borrowing interface of the WebAdmin.
It is strongly recommended to test the borrow environment. 
Set a relatively short Borrow Duration and you can test your 
setup without risking the loss of a license for a long period.
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Add/Repair (Reinstalling ArchiCAD)
If you already have ArchiCAD installed, and start the Installation 
Wizard, you are provided with two options:
1) Add will add new features to your current installation. You 

will see all available features in a list and you can check 
features to be added to your current installation.

2) Repair will reinstall ArchiCAD with the features of your 
current installation. You can choose to save your preferred 
files in a backup folder. If you select this option, a “backup” 
folder will be created in your ArchiCAD 19 folder. The name of 
the backup folder will contain the ArchiCAD version and the 
date of creation; and will include:

• your previous Add-on settings;
• your previous ArchiCAD 19 Library;
• your previous default Work Environment schemes.
After the repair process is complete, you can either delete these 
preferred files or reuse them by copying them back into your 
repaired ArchiCAD environment:
• copy your Add-On settings back to the respective sub-folders 

of your ‘ArchiCAD 19/Add-Ons’ folder;
• replace the library in the ‘ArchiCAD 19/ArchiCAD Library 19’ 

folder;
• replace your ‘Defaults’ folder in the ‘ArchiCAD 19’ folder 

(thereby including your current Work Environment, 
Translator and Template data).

Project files you saved into the ArchiCAD 19 folder will not be 
deleted or overwritten by the repair process.
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Uninstall ArchiCAD
To uninstall ArchiCAD 19 from Windows, it is best to use the “Add 
or Remove Programs” utility, accessible from the Control Panel.
On Mac, navigate to the “Uninstall.AC” folder in your 
ArchiCAD 19 folder, and select the “Uninstall.app” application. 
The Uninstall Wizard will help remove files which were installed 
by the ArchiCAD Installation Wizard. If you have more than one 
ArchiCAD installed, you may want to leave the CodeMeter and 
associated components installed on your system. If your driver(s) 
were installed in the course of installing ArchiCAD 19, the 
uninstaller includes a checkbox option: Remove hardware 
license driver(s). Make sure this option is unchecked if you do not 
want to remove your driver(s). The uninstaller doesn’t remove 
any files you have created in the ArchiCAD main folder - e.g. 
ArchiCAD project files that you saved into the ArchiCAD main 
folder.

Important: Do not remove the Java Runtime Environment 
before uninstalling ArchiCAD.

Silent Uninstall
For both Windows and Mac, a silent mode is available for 
uninstalling ArchiCAD. Use this mode to run the uninstall process 
from beginning to end without any further user input.
On Windows: open the “Run” window from the Start menu. In 
Windows Explorer, navigate to the Uninstall.AC folder in the 
ArchiCAD folder. Drag uninstaller.exe into the command line; the 
path is copied to the command line.
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Type the following after the path:
/silent
e.g.:
C:\Program 
Files\GRAPHISOFT\ArchiCAD 19\Uninstall.AC\uninstaller.exe /
silent

Note: If you want to avoid automatically restarting the 
computer after a silent uninstall, add the following to the end 
of the path:

/norestart
For example:
C:\Program 
Files\GRAPHISOFT\ArchiCAD 19\Uninstall.AC\uninstaller.exe /
silent /norestart
On Mac: open Terminal window, navigate to the Uninstall folder 
in the ArchiCAD install folder, then type:
uninstaller.app/Contents/MacOS/uninstaller -silent
e.g.: /Volumes/MyFolder/MySubfolder/ArchiCAD 19/
Uninstall.AC/uninstaller.app/Contents/MacOS/uninstaller -silent

Note: If you want to avoid automatically restarting the 
computer after a silent uninstall, add the following to the end 
of the path:

-norestart
For example:
/Volumes/MyFolder/MySubfolder/ArchiCAD 19/Uninstall.AC/
uninstaller.app/Contents/MacOS/uninstaller -silent -norestart
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BIM Server for ArchiCAD 19
An ArchiCAD client can access only those Teamwork projects 
which are located on a BIM Server of the same version number as 
the ArchiCAD client.
If the ArchiCAD client’s version number is different from the BIM 
Server version number, communication can take place only after 
you install a BIM Server of the same version number as the 
ArchiCAD client.
See also “Migrating the BIM Server” on page 35.

Hardware/Software Requirements
Recommended Operating Systems for BIM Server
• Windows 8.1 (64-bit version)
• Windows 8 (64-bit version)
• Windows 7 (64-bit version)
• Windows Server 2012 R2
• Windows Server 2012
• Mac OS X 10.10 Yosemite
• Mac OS X 10.9 Mavericks

Notes on Older Systems 
• Mac OS X 10.8 Mountain Lion is compatible but not tested by 

GRAPHISOFT.
• Mac OS X 10.6 Snow Leopard and Mac OS X 10.7 Lion are not 

compatible (BIM Server cannot be installed).
• Windows Server 2008 R2 is compatible but not tested by 

GRAPHISOFT.
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• Windows Vista is not compatible (BIM Server cannot be 
installed).

• Windows XP is not compatible (BIM Server cannot be 
installed).

Recommended Hardware
• Processor: 64-bit processor with four or more cores.
• RAM: 8 GB or more is recommended. For servers having a 

high number of active users and projects, consider 16 GB or 
more RAM.

• Hard disk space: 5 GB free disk space is required for the 
installation, 10 GB or more is required per active project.

Minimum Hardware
• Processor: 64-bit processor with two cores.
• RAM: 4 GB.
• Hard disk space: 5 GB or more is required for the installation.

Other Software
• Java 8 or later is required. You can find details here:

http://www.graphisoft.com/Java.
• Your network has to accommodate HTTP 1.1 standard.
• Supported browsers:

- Google Chrome (26 or newer)
- Internet Explorer (10 or newer)
- Safari (5.1 or newer)
- Firefox (20 or newer)
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Migrating the BIM Server
BIM Server for ArchiCAD 19 is a completely new installation, it 
cannot be installed as an additional module to a version 18 (or 
earlier) BIM Server. (You can install it on the same computer, but 
it must be managed separately with its own BIM Server Manager 
application or browser based interface.)

Migrating BIM Server Data from ArchiCAD 18
Use the Export and Import functions of BIM Server Manager (Users 
and Roles pages) to transfer user/ role data from BIM Server 18 to 
the newly installed BIM Server. 

Migrating BIM Server Data from ArchiCAD 17 and 
Earlier
The technology behind BIM Server for ArchiCAD 18 and later is 
fundamentally different from that of previous versions 
(ArchiCAD 17 and before), and you cannot migrate your BIM 
Server data (e.g. users or roles) from earlier server versions.
Install the new BIM Server and proceed to define users and roles 
as needed.
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Installation of BIM Server
Start installation by clicking Install GRAPHISOFT BIM Server from 
the start-up menu of the ArchiCAD DVD.

Important: A computer can run only one single BIM Server (of 
version 19 or later). If you wish to start another BIM Server 
(of version 19 or later), then it must be installed on a separate 
computer.

Program Folder Selection
After accepting the license agreement, you must define a location 
on your computer’s hard drive for installing the BIM Server.

Start Menu Location (Windows 7 Only)
Define the Program Folder (default folder: GRAPHISOFT) in which 
to place the following shortcut commands:
• BIM Server Manager;
• Reconfigure BS Manager;
• Reconfigure BS Module;
• GRAPHISOFT BIMcloud/BIM Server Reference Guide.

Installation Process
After viewing the summary of your installation choices, click 
Install to begin the installation process.
Click Next to proceed through the wizard.

Configure BIM Server
The BIM Server configuration process takes place after the 
installation. It involves the configuration of two components: BIM 
Server Manager and BIM Server Module.
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Page 1: BIM Server Manager Configuration

• Display name: By default, the BIM Server will use the name of 
your computer. All server pop-ups will identify the BIM Server 
by this name (regardless of the address used to access it).

• Port: Select a free port, or use the “Find an available port” 
command to automatically find one.

• Master Administrator password: Create a secure password 
for the Master Administrator (masteradmin) user. This 
Master Administrator will always be able to log in to the BIM 
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Server with full access to all hosted data. In case you forget 
the password, you must reconfigure your BIM Server and 
enter a new password.

• Data folder: This is the BIM Server Manager’s data storage 
folder.
Note: Projects will be stored in a different folder - as defined 
in the next step.

Click Next.

Page 2: BIM Server Module Configuration
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Port: Select a free port or use the “Find an available port” 
command to automatically find one.
Name: Name of your Module.
Project data folder: Enter or Browse the location of the default 
Project Data Folder. This will be the location of Teamwork 
Projects on this BIM Server.
Library data folder: Enter or Browse the location of the default 
Library Data Folder. This will be the location of Teamwork 
Libraries on this BIM Server. Click Start.

Page 3: Continue the Configuration in a Browser

Page 4: Log In to BIM Server
Enter the Master Administrator password to Log in to the BIM 
Server.

Page 5: Create the First User
Enter data for the first user. This user will be the first Server 
Administrator on the BIM Server. Fill in all the fields:
• Login name;
• Password, Verify password;
• Full Name;
• Email address.

Page 6: Set Up Mail Server
Use these fields to define the mail server which will to send 
information by email from the BIM Server to the users. The mail 
server definition can be modified later in the browser-based BIM 
Server Manager interface.
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Note: Using a mail server is optional. However, if you don’t 
define a mail server here, you won’t be able to send emails 
(e.g. password reminders) to users from the BIM Server.

Click Continue to finalize configuration.

Page 7: Complete Installation
It is recommended to log out now as the Master Administrator, 
and then log in as the newly created user. It is not recommended 
to use the Master Administrator account for everyday tasks.

Uninstall BIM Server
To uninstall the GRAPHISOFT BIM Server, you can use the 
Uninstall BIM Server shortcut located in the BIM Server’s 
installation folder. Double-click this shortcut to begin the 
uninstall process.
Within the uninstaller, you can choose whether to:
• Completely uninstall the BIM Server (removes the program 

with the option to remove all user data as well).
• Uninstall BIM Server Manager only (Use this option if you 

wish to connect your BIM Server to an existing BIMcloud).
To uninstall the GRAPHISOFT BIM Server from Windows, it is best 
to use the “Add or Remove Programs” or “Programs and 
Features” utility, accessible from the Control Panel.

Uninstall BIM Server Completely
Removes all components from your computer; option to also 
remove all data (users and projects).
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Uninstall BIM Server Manager Only
This will remove only the BIM Server Manager component, 
leaving the BIM Server Module intact. This will keep your projects 
intact.
You will be able to pair this BIM Server Module with an existing 
BIMcloud by turning it into a BIMcloud Server. 
See BIMcloud and BIM Server User Guide.

Licensing and Activation of BIM 
Server
The BIM Server does not require a separate license, but it must 
be activated before its use. 
Once you have installed and started the BIM Server, the BIM 
Server Manager interface will prompt you to activate it. This 
activation is free, one time only, and requires a GRAPHISOFT ID. If 
you do not have a GRAPHISOFT ID, the Activation process will 
help you to create one.

Upgrade BIM Server to BIMcloud
If you would like to extend your BIM Server, or if you would like 
to connect multiple BIM Servers under the same Management 
interface, you can upgrade the BIM Server to a BIMcloud.
This upgrade process requires a purchased BIMcloud license.
The upgrade process is not reversible; it is not possible to 
downgrade a BIMcloud to a BIM Server.
See Upgrade a BIM Server in the BIMcloud and BIM Server User 
Guide.
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Tools and Utilities
The following utilities are automatically installed on your 
computer together with ArchiCAD. However, it is possible to 
install them manually, if necessary, using the standalone 
installation packages available in the “Tools and Utilities” menu 
of the ArchiCAD 19 DVD.
Java runtime 
environment

Java 8 or newer is necessary to run ArchiCAD 19 
and BIM Server installer/uninstaller. On Mac, Java 
comes with the operating system. On Windows, 
the ArchiCAD 19 or BIM Server installer will 
detect your Java environment and will install Java 
if needed.

CodeMeter 
system 
components

A Protection Key driver (CodeMeter) will be 
installed as part of the installation process for 
ArchiCAD 19.

Adobe Reader Adobe Reader is necessary to read the PDF 
documentation provided in the ArchiCAD 19/
Documentation folder. If needed, you can install 
this program by inserting the ArchiCAD 19 DVD 
and selecting the application from “Tools and 
Utilities”; or browse the DVD contents to locate 
the Adobe Reader application.
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The following utilities are also installed with ArchiCAD 19. If you 
prefer not to install them, use Custom Installation and uncheck 
these options.

For more information about additional utilities, open the folders 
of the applications in the ArchiCAD main folder to find detailed 
descriptions.

Plotter Drivers With a typical install, ArchiCAD 19 will include 
a number of built-in drivers for a wide variety 
of HPGL compatible plotters.

GRAPHISOFT 
Shell Extension

Optional, for Windows only. Utility for 
extended GRAPHISOFT file property 
information on Windows.

Documentation PDF files offering help on using ArchiCAD and 
related functions.

ArchiCAD Help Context-sensitive electronic Help files for 
ArchiCAD.
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For ArchiCAD and ArchiCAD Library
To check for available updates of your localized version of 
ArchiCAD or ArchiCAD libraries, start ArchiCAD 19 and go to the 
Help menu:
The Check for Updates command will open your Internet browser 
and will guide you to the GRAPHISOFT update website. If there is 
no new update patch (hotfix) available for your release and 
language version of ArchiCAD, the web page will inform you that 
you are using an up-to-date version of ArchiCAD. If there is a new 
update patch available, the web page will automatically offer you 
the updater package that fits your current ArchiCAD installation.
You can choose to run the Check for Updates function 
automatically on a regular basis by setting the options at Options 
> Work Environment > Network and Update.

Note: If you have an updater patch installed and use the Add/
Repair function of your original ArchiCAD 19 Installer DVD, 
you will be prompted to re-apply the updates after the 
modification or repair is carried out. The ArchiCAD update 
option is available to holders of the Commercial or Education 
ArchiCAD 19 license.

You can find other downloadable materials (example files, 
goodies etc.) at 
www.graphisoft.com/support/archicad/downloads.

For BIM Server
BIM Server updates may be available from time to time at the 
GRAPHISOFT update website: 
http://www.graphisoft.com/downloads/archicad/updates.
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Compatibility Information
We suggest that you use previous versions of ArchiCAD to work 
on your current projects, until you feel comfortable and 
productive with the new version. We recommend that you keep 
your existing ArchiCAD environment for a time, even if you are 
using ArchiCAD 19.
ArchiCAD 19 provides downward compatibility to ArchiCAD 18 
with limitations: all information based on the new features and 
functions of ArchiCAD 19 will be lost in a file saved in ArchiCAD 18 
format.

Note: When back-saving your ArchiCAD 19 project to version 
18, any library parts that were earlier migrated from 18 and 
revised for 19 will be automatically replaced by their original 
counterparts in version 18.

When migrating earlier version files to ArchiCAD 19, you should 
use automatic Migrate Libraries option to ensure compatibility of 
library objects.
For more information, see the Migration Guide in ArchiCAD Help.

Opening ArchiCAD Files
ArchiCAD 19 can open ArchiCAD project files from earlier versions 
beginning with 8.1.
You cannot open project files from earlier versions directly in 
ArchiCAD 19. Please use ArchiCAD 8.1 or later version to convert 
them to a usable file format. We strongly recommend that you 
create an archive file (.pla) of each project you worked on with 
older ArchiCAD versions. Move a project onto ArchiCAD 19 only if 
you have archived it with the previous version.
See also the Migration Guide in ArchiCAD Help.
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Saving Project Files
ArchiCAD 19 can back-save project files in ArchiCAD 18 format 
only (among previous ArchiCAD file formats).

Plotter and Digitizer Support
Pen plotters (or pen-plotter mode on raster plotters) are not 
supported beginning with version ArchiCAD 8.1. Users who wish 
to use a pen plotter should keep an earlier ArchiCAD version. 
ArchiCAD 19 does not support earlier GRAPHISOFT digitizer 
drivers; however, manufacturers’ digitizer drivers work fine in the 
new ArchiCAD version in mouse-mode for sketches.
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